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USE OF THIS PROGRAM IMPLIES THAT YOU ACCEPT THE TERMS OF LICENSE AND THAT YOU 
HAVE READ, UNDERSTOOD AND ACCEPTED THE TERMS OF THIS LICENSE AGREEMENT AND 
LIMITED WARRANTY.

DEFINITION OF TERMS

"PUBLISHER" shall mean LaserSoft, Inc. and Limelight Publishing, LLC
"Representatives" shall mean distributors, retailers, representatives, employees, or any individual or 
organization operating on the behalf of, or with the consent of, PUBLISHER.
"PUBLISHER and its Affiliates" shall mean PUBLISHER and/or its Representatives.
"Product" shall mean Super Show & Go, the CD Navigator, their documentation and included files, and 
other related components.

License Agreement
UPON THE TERMS AND CONDITIONS SET FORTH HEREIN PURCHASER IS GRANTED A NON-
EXCLUSIVE ROYALTY FREE LICENSE TO USE THE PURCHASED Product FOR PERSONAL OR 
BUSINESS USE ON A SINGLE MACHINE.    PURCHASER MAY NOT USE PROGRAM FOR PROFIT 
WITHOUT THE PRIOR WRITTEN CONSENT OF PUBLISHER.

PUBLISHER GRANTS THIS LICENSE TO USE THIS SOFTWARE AND PRINTED DOCUMENTATION 
TO THE ORIGINAL PURCHASER.    THIS PRODUCT IS LICENSED FOR USE BY ONLY ONE PERSON 
AT A TIME.    PUBLISHER EXPRESSLY PROHIBITS INSTALLING THIS PRODUCT ON MORE THAN 
ONE COMPUTER IF THERE IS ANY CHANCE THAT BOTH COPIES WILL BE USED 
SIMULTANEOUSLY.    THIS RESTRICTION ALSO EXTENDS TO INSTALLATION ON A NETWORK 
SERVER, IF MORE THAN ONE WORKSTATION WILL BE ACCESSING THE PRODUCT.

IN NO EVENT MAY ANY FILE, PART OR COMPONENT OF THIS Product BE DISTRIBUTED WITHOUT 
WRITTEN AUTHORIZATION FROM PUBLISHER, INCLUDING, BUT NOT LIMITED TO:    THE 
EXECUTABLE FILE(S), DATA OR DATABASES, GRAPHIC COMPONENTS, AND DOCUMENTATION.

Disclaimer
THIS PROGRAM IS NOT PROVIDED WITH ANY WARRANTY OR GUARANTEE WHATSOEVER AS TO
THE ACCURACY OF RESULTS, COMPATIBILITY WITH OTHER PROGRAMS, OR THE SUITABILITY 
OF THE PROGRAM FOR ANY PARTICULAR USE. USE THIS PROGRAM AT YOUR OWN RISK!

PUBLISHER and its Affiliates CANNOT BE HELD RESPONSIBLE FOR ANY DAMAGES CAUSED BY 
THE USE OR MISUSE OF THIS PROGRAM. PUBLISHER and its Affiliates DISCLAIM ANY LIABILITY 
FOR DAMAGE TO COMPUTER, FILES, OR ANY OTHER EQUIPMENT, WHETHER DIRECT OR 
CONSEQUENTIAL. IF THE PROGRAM IS DEFECTIVE THE USER ASSUMES FULL RESPONSIBILITY 
FOR DAMAGE CAUSED    INCLUDING PAYING FOR REPAIRS, SERVICING AND ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES.    PUBLISHER and its Affiliates WILL NOT BE LIABLE FOR ANY 
DAMAGES INCLUDING LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION, ETC. CAUSED BY THE USE OR MISUSE OF THIS PRODUCT. THIS 
CLAUSE IS VALID EVEN IF PUBLISHER and its Affiliates WAS ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES.

IF THE PURCHASER IS NOT SATISFIED WITH THIS AGREEMENT HE OR SHE MUST RETURN THE 
COMPLETE PACKAGE WITHIN THIRTY (30) DAYS, INCLUDING ALL PRINTED MATERIALS TO 



PUBLISHER IN RESALEABLE FORM TO RECEIVE A FULL REFUND. IN NO CASE SHALL THIS 
REFUND BE MORE THAN THE ACTUAL PRICE PAID FOR THE PACKAGE AS APPEARING ON THE 
PURCHASER'S INVOICE.

THE PROGRAM IS SUPPLIED "AS IS". NO WARRANTIES OF ANY KIND EXPRESS OR IMPLIED ARE 
MADE AS TO IT OR ANY MEDIUM IT MAY BE ON. WE WILL PROVIDE NO REMEDY FROM FOR 
INDIRECT, CONSEQUENTIAL, PUNITIVE OR INCIDENTAL DAMAGES ARISING FROM IT, INCLUDING
SUCH FROM NEGLIGENCE, STRICT LIABILITY, OR BREACH OF WARRANTY OR CONTRACT, EVEN
AFTER NOTICE OF THE POSSIBILITY OF SUCH DAMAGES.

This Agreement is governed by the laws of the State of Indiana.



Configure Settings
The Settings dialog allows you to customize the CD Navigator to work the best for you.   

From this dialog, you can control features such as animation and sound effects, prompts, notices, 
auto-minimizing, and Program Listing format.

(Click on areas of the picture above for more information.)

Setting Explanations

Setting Explanation
Play Animation at Startup Toggle the startup animation on/off.
Play Button Sounds Toggle sound effects on or off.
Confirm before Deleting Asks you if you are sure, when you click the Delete 

button.
Confirm before Exit Asks you if you are sure, when you click the Exit 

button.
Minimize on Launch Minimized the CD Navigator when a program is 

launched.    (Same as the Program Manager feature by 
the same name.)

Display notice after install Displays notice when a program is installed.
Auto-Launch in Windows 95 Automatically runs the CD Navigator when the disc is 

inserted into the drive.    Only available on systems 
running Windows™ 95.

Display ASP Notation Displays the notation <ASP> next to programs which 



are written by ASP Authors.
Display Program Version Displays the version number next to each program in 

the Program Listing.
Display Horizontal Scrollbar Places a horizontal scrollbar at the bottom of the 

Program Listing, so that you can scroll left and rights to
view long entries.

Display Item Count Displays the number of items in the current category, at 
the top.

Display Item Tag Displays the type of file for multimedia files; for 
example, "SOUND" for sound files, "IMAGE" for 
graphic files, and so on.

Auto-play File When 
Launched

When a multimedia file is launched, and uses the 
Windows™ Media Player as a viewer, this option 
causes the file to begin playing immediately.

Auto-close When Finished When a multimedia file is launched, and uses the 
Windows™ Media Player as a viewer, this option 
causes Media Player to close automatically when the 
file.



Media Player
The Windows™ Media Player (MPLAYER.EXE) is often used to play a wide variety of 

multimedia files--from WAV and MIDI files to AVI Video and FLI Animations.    For ease of use,
our Super Show & Go Multimedia Effects Studio product offers certain basic control over how 
Media Player operates.    The two basic Media Player features which the CD Navigator can 
control are:

1. The ability to start playing the sound or video as soon as Media Player starts.
2. The ability to shut down Media Player as soon as the multimedia file is finished playing.

Both of these features can be set through the Configure Settings dialog.    For more 
information about how to use Media Player, please consult your Windows™ documentation.



Searching for Programs or Items

If you are looking for a specific type of program or item, the CD Navigator includes a 
powerful keyword searching feature.    Simply type the keyword you are looking for in the box 
labeled Text to search for and then click the Search button.    If matches are found, the Program 
Listing will display them.

Multimedia Effects Studio Super Show & Go allows you to further restrict the items you 
find by specifying the file categories to search (Programs, Images, Sounds, and Animations), as 
well as the specific types of files you are looking for.

The CD Navigator search engine will search through all program titles, descriptions, and 
authors for matches, and will display any item which contains the text you specified.

For example: If you specify the word "man" as the text to search for, the CD Navigator search 
routine will find programs that contain the following example text:

The Description: "...this address book allows you to track many different contacts..."
The Title: "Manager Pro v1.2"
The Author: "Robert Allsman, Jr."



Menu Bar
The menu bar across the top of the interface provides access to all features of the CD 

Navigator.    Below is a list of the menu items, and a description of the action that each performs.

Action Menu
The Action menu contains the same features as the Action Buttons area of the interface, and is 
provided for quick keyboard access to these commands.    In addition, the following choice(s) 
appear:

Launch Read Install
Order Form Search Add Item
Move Item Edit Item Delete Item
Exit

Category Menu
The Category menu lists the Category Buttons, just as they are displayed along the left side of 
the interface, and is provided for quick keyboard access.

View Menu
The View menu provides a keyboard shortcut to changing the Program Information Panel.    
Pressing the <F3> key, for example, is the same as clicking on the "Detail" tab.    In addition, the 
following choice(s) appear:

Description
Detail
Author
Show Item Path

Options Menu
Configure
Install File Sharing
Set Picture as Wallpaper
Restore Content

Help Menu
The Help menu provides access to our comprehensive on-line documentation.    You can jump 
directly to the Table of Contents by selecting the "Contents" option, search for a particular 
keyword, or access any of several "Special Help Topics".



Set Picture as Wallpaper

Another special feature of Multimedia Effects Studio Super Show & Go is the ability to 
set a bitmap as your Windows™ background wallpaper.    Your "wallpaper" is the image that you 
see on your Windows™ desktop, behind all of your application windows.

To use this feature, first select a bitmap that you like from the "Images" category.    Then 
choose "Set Picture as Wallpaper" from the "Options" menu (or just press CTRL-W), and the 
dialog above will appear.

Windows™ allows you to either "tile" or "center" your wallpaper image, and you can 
choose either option from this CD Navigator dialog.    Also, because many images look better on 
a black background, the CD Navigator allows you to specify "Set Pattern to Black."

Important Note:    This feature works best on systems with 256-color support or better.    On 16-
color systems, the images will look very "pixillated" due to the low number of colors to display 
with.    In addition, the images must be copied to your Windows™ directory in order to be used 
as wallpaper.    Because full-color images files can be large--often 500 Kilobytes or more--it is 
easy to use up your free hard drive space.    If you use this feature often, take care to delete old 
and unused graphics from your Windows™ directory.



Program Information Area
The Program Information area of the CD Navigator interface allows you to access a wide

variety of information very easily.    Information such as the program or item's size, a concise 
program description, and even the author's phone number and mailing address are just a click 
away!

(Click on areas of the picture above for more information.)

    
(Click on areas of the picture above for more information.)

Program Description Tab
Item Preview Tab
Program Detail Tab
Program Author Tab



Program Description

(Click on areas of the picture above for more information.)

The description window gives a brief, concise description about the selected program.    
Often, the description will exceed the length of the display area, so use the scroll bar to display 
more text.

You can view the detail pane by clicking on the "Description" tab.    Alternatively, you 
can select View/Description  from the menu, or press the F2 function key.



Item Preview

(Click on areas of the picture above for more information.)

The preview window allows you to quickly examine a graphic or multimedia file without 
actually launching it.    For example, while browsing through the "Images" category, you will see 
smaller-sized versions of the graphic files in the preview window.

(Click on areas of the picture above for more information.)

Multimedia clips, such as sound and video files, display a VCR-style control in the 
preview window.    Simply click the VCR "play" button to start playing the multimedia clip, and 
use the Pause and Stop buttons as desired.



Program Detail

(Click on areas of the picture above for more information.)

The detail window displays some additional information about the program, such as the 
type, registration cost, size, version number, and CompuServe Shareware Registration Number 
of the program.

You can view the detail pane by clicking on the "Detail" tab.    Alternatively, you can 
select View/Detail from the menu, or press the F3 function key.



Program Author

(Click on areas of the picture above for more information.)

The author pane displays various information about the author of the selected program.    
This pane is divided into two sections... at the top of the author information pane, you will see 
the author's name, company, and mailing address.    At the bottom, you will see a list of other 
ways to contact the author, such as phone number, FAX number, and E-mail addresses.

Order Phone Use this phone number to register the software.
Phone The author's phone number.
FAX The author's fax number.
BBS The author's BBS number.
CIS The author's CompuServe ID.
Internet The author's Internet address.
Genie The author's Genie ID.
BIX The author's BIX ID.

You can view the detail pane by clicking on the "Author" tab.    Alternatively, you can 
select View/Author  from the menu, or press the F4 function key.



E-mail Addresses
Electronic Mail, or "E-mail" addresses are often the fastest and most economical way to 

reach an author.    Since many authors have full or part-time careers, in addition to the Shareware 
businesses they run, they are often unreachable during the day.    The Super Show & Go CD 
Navigator stores and displays addresses for these on-line services: CompuServe, Internet, Genie, 
and BIX.

If an author has an email addresses for a service that you don't subscribe to, there are 
often ways to send mail through a "gateway", or a bridge between the services.

Example #1:

If the author has an Internet address, such as..."bob@bobware.com", but you only have a
CompuServe account, simply address your letter to:

INTERNET:bob@bobware.com

Example #2:

Alternatively, if the author has a CompuServe address, such as... "12345,6789", but you 
only have an Internet account, address your letter to:

12345.6789@compuserve.com

(NOTE:    Please note that the comma in the CompuServe address has changed to a period
in the Internet address.    Also note that there are no spaces in either address format.)

Consult your on-line service's manual for further details on how to send mail to outside 
services.



This section contains helpful notes and Frequently Asked Questions (FAQ) of our 
techncial support department.    Because of the power and complexity of the Windows™ 
environment, many different messages can appear, which all have the same cause.    For this 
reason, multiple questions and multiple answers may be grouped together below.

Q: My computer reports "Unable to Read Drive D:".
Q: When I access the CD-ROM, I get a "Bad Media" message.
A: The most common reason for these errors is dust or fingerprints on the CD.    Use a soft, 

clean cloth, such as a cotton T-shirt and some water.    Wipe the disc from the center to the
edge.    If necessary, you may use a mild detergent, but NEVER use solvents of any kind 
as they may cause permanent damage to the CD.    If problems continue to occur, it is 
possible that your CD-ROM drive may need cleaned or repaired.    A scratch or other 
permanent mark on the underside of the CD may also cause this problem.

A: The second most common reason for these errors is that your drive is dirty or 
miscalibrated.    If problems persist, you may want to have your drive inspected by a 
professional.

Q: The 'Add Item' and 'Delete Item' buttons are always disabled.
A: Windows™ must have file sharing enabled in order for these features to become 

available.    You must have a file sharing driver loaded, such as VSHARE.386 or 
SHARE.EXE to take advantage of these features.    For more information, please see the 
help file topic: 'What is File Sharing?'.

Q: I have installed VSHARE.386, but the 'Add Item' and 'Delete Item' buttons are still 
disabled.

A: After installing VSHARE.386, Windows™ must be restarted in order to enable file 
sharing.    If you have already restarted Windows™, and the buttons still appear grayed, 
then you are probably running Windows 3.1 in STANDARD mode.    VSHARE.386 (and 
all other virtual device drivers) will only load when you are running Windows™ 3.1 in 
ENHANCED mode.    Please see your Windows™ documentation for more information 
about running Windows™ in Enhanced Mode.    If you cannot run Windows™ in 
Enhanced mode, you may still be able to enable file sharing by using SHARE.EXE.    
Please consult your DOS documentation for details on installing SHARE.EXE.

Q: When I launch a multimedia file (such as a sound or video), I get the error "This 
device cannot play."

A: Your system has incorrect information in your WIN.INI file about which file types can be
played.    Media Player attemps to launch the file, but then discovers that it does not have 
an appropriate driver.    If you are an expert Windows™ user, you may want to examine 



the [MCI Extensions] section of your WIN.INI file.

Q: When I launch a multimedia file (such as a sound or video), I get the error "Media 
Player cannot find a device to play AVI files".    (or WAV files, FLI files, etc.)

A: Your system has no associated viewer for the selected multimedia file, and Media Player 
does not have an appropriate driver to play the file with.    In order to play the selected 
file, you need to have a viewer application or device driver that support the appropriate 
file format.

Q: When I launch a data file (such as an image, a sound or video), I get the error "There 
is not an associated viewer for the BMP file format."    (or WAV files, FLI files, etc.)

A: Your system has no associated viewer for the selected data file.    In order to view the 
selected file, you need to have a viewer application that supports the appropriate file 
format.    See File Associations for more information on how to specify a viewer.

Q: When launching a .PCX file under Windows™ 95, Paint starts can I get an error 
message which states, "Paint cannot read this file.    This is not a valid bitmap file."

A: The Windows™ 95 version of PaintBrush does not support the .PCX file format any 
longer.    In order to view .PCX files, you will need to use a different viewer.

Q: I can't preview an item which I added to the database.
A: Any item you add to the database has an optional description which you can enter... in 

order to display this description, the "Description" tab must remain visible, even for 
Multimedia items such as WAV files.    However, you can still freely launch these files, 
just like any of the other multimedia files included on the CD-ROM.

Q: I get a 'Path / File Access' error when running a program from the CD-ROM.
A: If this error occurs while you are running a Shareware program, then the program is 

attempting to save information into its own directory, on the CD-ROM.    Because CD-
ROM's are read-only, the program cannot save information to the disc.    Simply install 
the program to your hard drive (using the Install button), and launch it from the Program 
Manager (not the CD Navigator).    The program will then be able to function normally.

Q: After installing a Shareware program, I tried to run it, and got a 'File not found' error.
A: Consult the program's documentation for proper placement of necessary files.    Because 

the CD Navigator cannot know where a program wants its files, it copies all necessary 
files into a single directory.    This usually works very well, but may fail on systems with 
unusual configurations.    Programs which require more complex installation usually 
come with their own setup program, and CD Navigator has no control over the 
installation process.



Q: A message box says 'VBRUN300.DLL' is in use.    Cannot Continue.
A: Shut down all applications then retry running the program from the file manager.



Drivers and Viewers on this CD
Because of the wide variety of multimedia content which is available for use on your PC, 

it it very possible that you will not have an appropriate driver installed to handle a particular file 
format.    For example, even though AVI video files are the native video format for Windows™, 
you still have to install a special driver to play them.

To help maximize the power of your computer, we have included the following drivers 
and viewers on the CD:

Video for Windows™ 1.1

Video for Windows™ is a driver which allows you to play AVI files on your Windows™ 
system.    The driver needs to be installed (by running the included Setup program) before it can 
be used.

The English driver is located on the CD-ROM in the directory:
\DRIVERS\VFW

The German driver is located on the CD-ROM in the directory:
\DRIVERS\VFW\GER\DISK1

The French driver is located on the CD-ROM in the directory:
\DRIVERS\VFW\FRN\DISK1

Autodesk Animation Player for Windows™, v1.10

The Autodesk Animation Player is a viewer which allows you to play FLI, FLC, and AAS
file formats.    Because the player is an application, we have left it uncompressed on the CD-
ROM so that you can run it without needing to install it.    In fact, if the CD Navigator cannot 
find a viewer for FLI, FLC, or AAS files on your system already, it will automatically use the 
Animation Player from the CD.

The viewer is located on the CD-ROM in the directory:
\DRIVERS\AAWIN



Installing a Program
If you particularly like a program and would like to install it to your hard drive, select the

program and click on Install.    Installing a program allows you to run it without having the Super
Show & Go CD-ROM in your drive, and without using the CD Navigator interface.    An icon 
will be created for you in the Program Manager, to make launching the program easy.

Programs which do not have their own installation procedure will be installed by the CD 
Navigator's built-in installer.    When this happens, you will see a dialog appear that looks like the
one below.    Programs which do have their own custom installation program will all appear 
differently, and ask different questions... simply follow the instructions that program gives you to
install the program.

CD Navigator's Built-In Installer

The "Install Program or Item" dialog allows you to specify the location that you want to 
install the selected program.    The CD Navigator will automatically pick a default directory for 
you, which is often the best choice.    Once you have selected a destination path (or chosen to use
the default installation directory), click the "OK" button to complete the installation.

If you wish to select a different path than the default one provided, you may type it 
directly into the Installation Directory box, or browse for a destination by clicking the Browse 
button.



This section provides important information on how to use the CD Navigator interface 
and its many powerful features.    Many of the pictures you will see in this section contain "hot-
spots" which you can click on for more information.

(Click on areas of the picture above for more information.)

For information on an area of 
the CD Navigator interface, please 
click on the desired area of the 
interface picture, or select from 
these areas...

Menu Bar
Category Buttons
Program Listing
Program Information Panel
Action Buttons
Help Bar

For ease of use, the CD Navigator interface is divided into four major areas.    These areas
are: the Category Buttons (along the left side), the Program Listing (in the center), the Program 
Information Panel (center of the right side), and the Action Buttons (bottom right).    To learn 
about each of these areas, please click on that area of the above picture, or click on its name, 
below...

Category Buttons
Program Listing
Program Information Panel
Action Buttons

In addition to these four major areas, there are two additional areas which you will find very 
useful.    The menu bar across the top of the CD Navigator allows access to all features of the 
product, including some "special" features which cannot be accessed through the command 
buttons.    Along the bottom of the interface is an area called the "Help Bar", which provides 
context-sensitive help on the fly.    For more information, please click on the appropriate topic 
below:

Help Bar
Menu Bar



This section provides quick access to information about the many commands fand 
features of the CD Navigator.    For quick access while using the CD Navigator, you can press 
the <F1> key or click the Help button on any dialog, and the appropriate help page will appear.

Commands
Add Item
Configure
Delete Item
Edit Item
Exit
Install
Install File Sharing
Launch
Move Item
Order Form
Read
Restore Content
Search
Show Item Path

Features
Author Information Panel
Category Buttons
Program Description Panel
Program Detail Panel
Windows™ 95 features



This section contains information on how to obtain technical support, both for the CD 
Navigator interface, and for the individual programs or items contained on the Super Show & Go
products.    If you are having difficulty using the Super Show & Go CD Navigator, please read 
the Frequently Asked Questions section first to resolve common problems.

Technical Support for programs on the Super Show & Go CD-ROM

Our expert technical staff works diligently at selecting only the best and most useful 
program for our Super Show & Go CD-ROMs.    However, depending on your system 
configuration, and your expertise using a computer, you may have problems or questions about 
programs which are on the Super Show & Go CD-ROMs.

If you have a question about one of these programs, you should contact the author of the 
program for assistance.    He or she can provide the best help for your problems, and the best 
answers to your questions.    It is important to realize, however, that due to the costs and time 
involved, many authors require you to register the program first, before technical assistance can 
be provided.    For information on an author's policies, you should examine the program's 
documentation, as well as the screens that appear when you run the program itself.

To make our products as easy to use as possible, we have provided a variety of 
information on how to contact the author.    This information can be found on the CD Navigator 
main screen, by clicking on the Author Information tab.

Due to the huge number and tremendous variety of programs we distribute, we cannot 
provide technical support for the many programs on our CD-ROMs.    Because we did not write 
these programs, we do not have access to information about their design--or how to provide 
technical assistance for their use.

Technical Support for the CD Navigator interface

If you have a problem actually starting or using the CD Navigator, we are happy to 
provide free technical assistance to help you get started!

Before contacting technical support, please read this entire help document, as many 
common questions are answered here.    If the information in this document does not answer your
questions, please contact our Technical Support department at the numbers below.

If Super Show & Go displays an error message, please write down that message 
completely, and have it ready when you call.    Technical support problems are often much easier 
to solve if you are at your computer when you contact us.

Also, please note that at this time, we can only provide technical assistance in English.    
If you do not speak English fluently, but can read and write English, please contact us by FAX at 
the number below.

How to Contact Technical Support



Limelight Publishing, LLC
2718 Rand Road
Indianapolis, IN    46241      USA

Phone: (317) 487-8807
FAX: (317) 487-8810
Hours: 9 AM to 6 PM, Monday through Friday, 
EST.

After hours and on weekends and holidays, you 
can reach us by FAX.



Shareware is an exciting marketing method which allows you to try top-quality software 
before you pay the author.    With Shareware, you cannot be disappointed spending money for a 
program that's not right for you.    The small fee you pay to us covers only the duplication and 
distribution costs, and permits you to evaluate the program.

If you continue to use the program, you must send the author an additional payment 
which may entitle you to technical support, printed manual, bonus programs, and more.    Your 
payment supports authors, enabling them to continue writing newer and better Shareware 
programs.



File Sharing is the ability for two or more programs to "share" a file at the same time.    
Many database engines require file sharing support, due to the tremendous amount of file 
operations that are done.

Does my system already support file sharing?

Although newer versions of Windows™, such as Windows™ for Workgroups, 
Windows™ NT, and Windows™ 95 have built-in file sharing capabilities, Windows™ 3.1 does 
not.    If you are using Windows™ 3.1, you will need to install file sharing capabilities.

Microsoft provides two different drivers, each which support file sharing.    The best 
method is to use a special Windows™ driver called VSHARE.386, which the CD Navigator can 
install for you--see below for details on how to install VSHARE.386.    The second driver that 
you can use is SHARE.EXE, a DOS-based program which can be run from the DOS command 
line, or added to your AUTOEXEC.BAT    file.    SHARE.EXE is an older solution, which in 
most cases should be considered obsolete.    VSHARE.386 should be used whenever possible.    
If, however, VSHARE.386 cannot be used on your system, SHARE.EXE should work fine.    For
information on installing SHARE.EXE, please consult your DOS manual.

Important Note:      If your computer is attached to a network, please consult your network 
administrator before installing file sharing, or making any changes to your system configuration.

How to install VSHARE.386

If your system does not already have file sharing support installed, you will get a message
the first time you run the CD Navigator.    Immediately following the message, you will be asked
whether you want the CD Navigator to install file sharing for you.    If you choose not to install 
file sharing, you can change your mind at any time by clicking on the Options menu and 
selecting "Install File Sharing".

Important Note:    VSHARE.386, like all virtual device drivers, will only work if you are running 
Windows™ in "386 Enhanced" mode.    To make certain that you are, choose "Help/About" from 
menu of Program Manager.    If you are running Windows™ for Workgroups, Windows™ NT, or 
Windows™ 95, file sharing is already enabled.



Limelight Publishing is a CD-ROM publishing company with many very successful 
product lines including the Super Show & Go CD Navigator, the Platinum Shareware Series, the 
Companion CD-ROM Series, the Show & Go CD Navigator series, and other full featured 
multimedia products.

Limelight is known throughout the industry for its high-quality products and powerful, 
user-friendly interfaces.    We strive to present the information on our discs in a powerful, 
intuitive, and interactive manner.    Our goal is to help you experience the full power and 
flexibility of your computer!

We are always interested in discussing ideas and industry trends...    Please let us know 
your suggestions and ideas!    You can reach us at the address below, or send your ideas and 
thoughts straight to our Board of Directors by sending CompuServe mail to us at 72704,1102.    
We look forward to hearing from you!

Please send suggestions and comments 
to:

Limelight Publishing 
2718 Rand Road
Indianapolis, IN    46241      USA
Phone: (317) 487-8800
FAX: (317) 487-8810



About LaserMagic

LaserSoft is the first value-priced CD-ROM only publisher in the business.    Our products range 
from great Windows shareware collections to state-of-the-art games like Rise of the Triad!

Our Customers
LaserSoft is a unique blend of industry experts with courage to publish easy-to-use software on 
state-of-the art media, CD-ROM. We encourage authors to bring innovative, high quality 
software to the consumer channels such as:

* Target
* Marshalls
* Kay Bee Toys
* Toys 'R Us
* Computer City
* CompUSA
* Software Etc.
* Babbages
* Electronic Boutique
* Eckerd Drug
* and many others...



Congratulations!    You have purchased the highest quality, most current shareware CD-
ROM available today!    Every title in the Super Show & Go series includes hundreds of 
Windows™ shareware programs, clipart, fonts, or multimedia files, accessible through our 
revolutionary CD Navigator interface!



Action Buttons
The lower-right area of the CD Navigator interface contains eight command buttons.    

These buttons are placed for easy-access to the most commonly used features of the CD 
Navigator interface, such as Launching a program, Reading a program's documentation, and 
Installing a program.

(Click on areas of the picture above for more information.)

For more information on a particular command button, either click on the image of the 
button above, or on the text description below.

Command Action
Launch Launches the selected program or item.
Read Displays the documentation for the selected program or item.
Install Installs the selected program or item to your hard disk.
Order Form Displays the order form for the selected program or item.
Search Displays the keyword searching window.
Add Item Adds a new program or item to the list.
Move Item Moves the selected program or item to a different category.
Edit Item
Delete Item Deletes the selected program or item.
Exit



Launching a Program
The Launch button starts the selected program.    Some programs on the CD-ROM may 

not be launched due to their behavior.    These programs must be installed first, because they need
to store information into their own directories.    The Launch button will be grayed out when a 
program cannot be run from the CD-ROM.

The CD Navigator supports launching data files, such as text files (*.TXT), bitmaps 
(*.BMP), and sound files (*.WAV).    You can add these files to the CD Navigator database at any
time using the Add Item button, and them display them with the Launch button.    To determine 
which program to use as a viewer, the CD Navigator uses your system's file manager 
associations.

Shortcuts & Special Keys
1. Double-clicking on a program or item will automatically launch it.
2. CTRL-L is also a launch shortcut.    Select the item you wish to launch, and press 

CTRL-L on your keyboard.    This performs the same action as clicking the Launch 
button.

3. Certain Super Show & Go titles make use of special keys which augment or modify the 
launch action.    For information about this feature, see Special Launch Hot Keys



Special Launch Hot Keys
Certain Super Show & Go titles have special launch key features, to make your work 

faster and more productive.    Below are listed, by title, any special launch hot keys which may be
available.

Colossal Clipart

Our Clipart Super Show & Go titles offer each piece of clipart in four different file 
formats.    Because you may have several graphics tools available on your system, you may have 
set different file associations for each type, to help you work better.    The CD Navigator allows 
you to control which file format is displayed by using the following hotkeys...

Hot Key(s) Action
(none) Display default file format.    The default file format 

is set through the configure dialog box.
CONTROL Display BMP file format.
SHIFT Display PCX file format.
SHIFT+CONTROL Display EPS file format.
ALT+CONTROL Display TIF file format.

Use these hot keys while launching the program... for example, if you hold down the 
CONTROL key while you click on the Launch button, the BMP version will be launched.    If 
you hold down the ALT and CONTROL keys while clicking Launch, the TIF version will be 
launched.



Reading a Program's Documentation
If you would like to know more about a program, select the program from the Program 

Listing and click on Read.    The CD Navigator will display the program's own documentation, if 
available.    If there is no documentation for the selected item (this is common for items such as 
pictures and sound files), there are other sources which may be able to provide the information 
you seek.

The Order Form button, like the Read button, displays a file containing the order form 
and ordering instructions.

The Description panel of the Program Information area contains a brief, concise 
description about the program.

Running the program will often provide valuable information, as well.    If the program 
has a help menu, try viewing the About box... it may contain instructions on how to use the 
program.



Browse

(Click on areas of the picture above for more information.)

When installing a program or item, you may wish to "browse" for a directory, instead of 
accepting the default path that the CD Navigator chooses.    This is useful when, for example, 
you want to install a game into your own special directory.

Use the drive and directory controls to locate the directory you want to use.    If you want 
to create a directory beneath the current one, you can use the Create Dir button.    Once you have 
chosen the directory you want to install the program in, click on the "OK" button.    CD 
Navigator will return you to the Install Program dialog, with the path you chose displayed in the 
Installation Directory box.



Creating a Directory

Type the name of the directory in the box labeled New Directory.    Remember, the name 
can not be longer that eight characters.    The full path of the directory is shown in the box 
labeled Full Directory Path.    Click on the Create Directory button to make the new directory, or 
Cancel, if you change your mind.



Order Form
Many of    the programs contained on the Super Show & Go series of CD-ROMs are 

Shareware programs.    To make registering your favorite programs as easy as possible, many 
authors have provided an Order Form which you can print out and mail.    If there is no order 
form for the program, please try the Read button and the program's About box.



Deleting a Program or Item
Deleting a program will remove it from the database, and it will no longer be displayed in

the Program Listing.    This is useful for "hiding" programs which you may never use.    If the 
program is one that you added then it will be permanently removed from the database.    
However, if you delete one of the original programs it can be 'undeleted' by selecting Restore 
Content from the Options menu.



Adding a Program or Item
In addition to the hundreds of programs available on each Super Show & Go CD-ROM, 

you can add you own favorite programs to the CD Navigator database!    This is a great way to 
categorize and catalog programs which get easily misplaced.    Once a program is added, you can 
launch it just like any other program.

Adding a Program to the database involves two steps:    First, you must locate the 
program or item on your hard drive.    Second, you can enter information about the program, 
including a Title, Description, and Category.

Locating the Program or Item

Use the Add Program dialog to locate the program or item you wish to add.    If you are 
adding a program, make sure to select the program itself, and not one of its data files.    Programs
typically end in the extension ".EXE".    Click OK when you are done or click Cancel if you 
decide not to add a program.

Entering Program Information



Type the name of the program in the box labeled Program Title.    Type brief description 
in the box labeled Program Description and select a Category for the new program.    Click on 
OK when you are done.    The program you just added is now available under the category you 
selected!

Adding Data Files

The CD Navigator has an intelligent launching algorithm which allows you to add data 
files, such as text files (*.TXT), bitmaps (*.BMP), and sound files (*.WAV) to the database.    
Simply select the file you want to add, just as you would select a program.

When you launch a data file from the interface, the CD Navigator will make use of your 
file association to determine which viewer to use.    In this way, you can have full control over 
what program to use as a viewer, for each and every type of data!



Exiting the CD Navigator
Click on the Exit button to leave the Super Show & Go CD Navigator.    If you have the 

"Verify on Exit" option turned on, you will be prompted before exiting.



Help Bar

The context-sensitive help bar always displays a simple hint or suggestion for using the 
item that the mouse cursor is pointing at.    This part of the screen gives a little extra help, such as
what action a button will perform, or why a button is grayed-out.



Install File Sharing
This option will install file sharing capabilities.    File sharing is necessary in order for 

you to use CD Navigator features which require changing the database--features such as Add 
Item, Edit Item, Move Item, and Delete Item.



Show Item Path
If you are an advanced computer user, you will find this feature invaluable.    This feature 

displays the exact location on the CD-ROM of the selected item.    For single-file items, such as a
bitmap or sound file, the filename will indicate that particular item.    For multiple-file items, 
such as an application, the filename will indicate the primary file.    In most cases, this is an EXE 
file, but can be an SCR file (screensaver), VBX, DLL, or other file.



Program Listing
The program listing is the central focus of 

the CD Navigator interface.    Most of the actions 
you will perform in the CD Navigator, such as 
launching a program, reading a program's 
documentation, and installing a program, will act 
on the program that you have selected in the 
program listing.

For example, if you have "Fredrick's 
Famous Calculator" selected in the program listing 
window, and click on the "Launch" button, the CD 
Navigator will run "Fredrick's Famous Calculator."  
Likewise, clicking "Install" will install that 
program.    Other commands which act on the 
selected program are "Delete Item", "Order Form", 
"Edit Item", and "Move Item".

In addition, the information displayed in the
Program Information area is information that 
pertains to the selected program.

The program listing is the central focus of the CD Navigator interface.    Most of the 
actions you will perform in the CD Navigator, such as launching a program, reading a program's 
documentation, and installing a program, will act on the program that you have selected in the 
program listing.

For example, if you have "Fredrick's Famous Calculator" selected in the program listing 
window, and click on the "Launch" button, the CD Navigator will run "Fredrick's Famous 
Calculator."    Likewise, clicking "Install" will install that program.    Other commands which act 
on the selected program are "Delete Item", "Order Form", "Edit Item", and "Move Item".

In addition, the information displayed in the Program Information area is information that
pertains to the selected program.

Commands such as "Search" and "Exit" are not specific to any program, and therefore 
don't affect the currently selected program in any way.

The programs and items displayed in the program listing can be changed by selecting a 
new category button, or by performing a search.

The notation 'ASP' indicates that the program complies with the standards of the Association of 
Shareware Professionals.



Edit Item

(Click on areas of the picture above for more information.)

The Edit Item feature allows you to change the Title, Description, or Category of an item 
that you added.    You may only edit programs that you have entered using the Add Item feature.



Restore Content
Selecting "Restore Content" from the Options menu will reset the database to its original 

state.    All programs when have been 'deleted' will be available again, and all programs which 
you have added will be removed.



Moving a Program or Item

(Click on areas of the picture above for more information.)

You can move a program to a different category using the Move Item menu option.    The 
program you are moving is shown in the Program Title box.    Simply select a new category and 
then click OK.    You can also double-click the new category, and the program will be moved.



Empty Category

When there are no programs associated with the selected category this window will be 
displayed.    One example being the personal category when the program is first installed.    A 
category might also be empty if all its programs are deleted.    To change this, select the restore 
content feature or add a program to the category.



Category Buttons

(Click on areas of the 
picture above for more 
information.)

The Super Show & Go CD Navigator uses 
category buttons to help you sift through the hundreds 
of programs on the CD-ROM.    Along the left side of 
the CD Navigator interface are between 6 and 20 
category buttons, depending on the Super Show & Go 
product which you are using.

To view the programs in a particular category, 
simply click on that category button.    For example, on 
our Game Gallery, you can view all available strategy 
games by clicking on the "Strategy" button.    The 
programs or items in that category will be displayed in 
the Program Listing, at the center of the CD Navigator 
interface.    If you do not have a mouse on your system, 
you may select any category by using the Category 
menu.

The "Personal Files" category, at the bottom of 
the Category button bar, is a special category that is 
reserved for your own files.    You may add or move 
your favorite programs to this category, keeping them 
easily accessible at all times.



How To Register
Many of the programs included on the Super Show & Go CD-ROMs are Shareware.    

Shareware programs are programs which you are allowed to try for a period of time (usually 30 
to 60 days), after which you must register them with the author.    The authors of these programs 
work extremely hard to bring you the best programs possible, investing months and often years 
in the development process.    Please make sure to register all Shareware programs which you 
enjoy and intend to use!    This allows authors to develop newer and better programs for your 
enjoyment, at prices far below retail cost!

Information about program registration can be seen by clicking on the Order Form 
button.    If you cannot find the information you need, or there is no Order Form file available for
the selected program, then click on the Read button for the program's documentation.    If neither 
of these methods work, you should look in the program's About box, or contact the Author 
directly for information on how to register the program.



Installation Successful
The Super Show & Go CD Navigator installed your selection successfully.

If you installed a program, you should find an icon available in the Program Manager.    
Simply double-click on the icon, as you would launch any other program.

System files, such as fonts and screen savers, will now be available in their native 
environment.    For example, if you installed a font, it will now appear in the fonts list of your 
favorite programs.    Windows screen savers can be accessed from the "Desktop" icon of your 
Control Panel.

Data files, such as bitmaps and sound files, are installed in the directory that you selected.
Since bitmaps and sound files must be loaded by another program in order to use them, no icon 
is created for these files.



Unable to Install Selection Successfully
The Super Show & Go CD Navigator was unable to install your selection successfully.

There are several reasons why an installation can fail.    Listed below are some of the most 
common causes you should check for...

Not enough disk space.    You must have enough space on your selected drive in order to 
install the selected item.

The selected drive is read-only.    You must be able to write to the drive you select for 
installation.    For example, you cannot install a file onto your CD-ROM drive, because CD-
ROM's are a "read-only" media.    If you are installing to a floppy diskette, make certain that the 
disk has the write-protect tab off.



File Associations
The CD Navigator has an intelligent launching feature, which allows you to view data 

files easily.    In addition to programs, which can be run by themselves, you can "Launch" 
bitmaps, sound files, movies, icons, and thousands of other file formats.    The CD Navigator 
uses the same viewers that appear whenever you launch a data file from the File Manager.

For example, when you first install Windows™, Paintbrush is the associated viewer for 
bitmap (*.BMP) files.    Therefore, when you launch a bitmap file from the CD Navigator will 
use Paintbrush to view it.    If, however, you find a bitmap viewer that you like better than 
Paintbrush, you can "associate" it with the bitmap file format so that it becomes the new default 
viewer.

All file associations are controlled and can be changed through the File Manager's 
File/Associate menu option.    For more information, please consult File Manager's online help, 
and search for the keyword "associate". "a"



Windows™ 95 Features
We always strive to bring the newest and best technologies to your desktop, to make your

work more productive, and your play more enjoyable!    The CD Navigator interface is 
continually evolving, and will improve with each new release of our Super Show & Go product 
line!    If you have Windows™ 95 now, or purchase it later, CD Navigator can offer the following
additional features:

Auto-Running the CD Navigator

All of our Super Show & Go CD-ROMs support a special Windows™ 95 feature called 
"AutoRun".    This feature makes it possible to run the CD Navigator simply by putting the CD-
ROM in your drive!    You no longer need to click on an icon to start the interface.    If you do not
want the CD Navigator to launch automatically, you can disable AutoRun through the Configure 
dialog.



Association of Shareware Professionals (ASP)

The Association of Shareware Professionals (ASP) is a trade association which oversees and 
regulates the actions of Shareware Authors, Shareware Distributors, and Shareware BBSs--to 
maintain a high standard of quality and customer service in the Shareware industry.



Cancel Button

Click the Cancel button to abort the current action, and close the dialog.



CompuServe Software Registration Number

The CompuServe Shareware Registration number, or SWREG #, is a number which you can use 
to register the Shareware program you have selected.    The registration cost of the program will 
be billed to your CompuServe account, and the author will be notified of your registration.    This
is a very convenient way of registering programs; however, due to the commission which 
CompuServe earns, the author may need to charge a slightly higher registration fee when you use
this service.

For more information on this service, please check your CompuServe manual, or call 
CompuServe at 1-800-848-8990 (or 1-614-529-1340).



Control Panel

The Control Panel is a system configuration tool that comes with Windows.    It allows you to 
specify settings for your Windows configuration, such as how fast your mouse cursor moves, and
what your desktop background looks like.    The Control Panel can be found in the Main group of
your Program Manager.

(Click on this icon to launch your systems Control Panel.)



Data Files

A data file is a file which contains certain information.    In order to view a data file, a compatible
viewer must be used.    For example, a bitmap (.BMP) file can be viewed by Windows 
Paintbrush, and a sound file (.WAV) can be played by the Sound Recorder.    Examples of data 
files are:

Bitmap files (.BMP)
Sound files (.WAV)
Movie files (.AVI, .MPG)
Animation files (.FLI, .FLC)
Icon files (.ICO, .ICL, .DLL, .EXE)



Directory Selection list box

Use the directory selection list box to choose a directory from the current drive.



Drive Selection combo box

Use the drive selection combo box to select one of your systems drives.



File Selection list box

Use the file selection list box to select a file.



File Type Selection combo box

Use the file type selection combo box to control what kinds of files are displayed in the file 
selection list box.



Freeware Programs

A freeware program is a program that is owned and Copyrighted by an author, but which is 
freely distributable, and has no charge for use.

see also Public-Domain
see also Shareware



Help Button

Click the Help button to display information about the current task you are performing, or to find
out how to use a particular dialog or screen.



OK Button

Click the OK button to perform the current action, and close the dialog.



Personal Files Category

The Personal Files category is a category designated for your own added programs.    When you 
add a file to the CD Navigator database, you can store it in any category you wish.    However, 
storing it in your Personal Files category makes it very easy to find your own added files.



Program Size

The size of the program represents the amount of space that the program will use if you Install it 
to your hard drive.    Because many Windows™ programs use shared files, called DLLs, this size 
often represents a maximum amount of space that the program will need.    However, during 
installation of the program, you may need as much as twice this amount of space available in 
order for the program to install successfully.



Program Version

The version of the program is a number assigned to it to help you determine if it is the most 
current release.    This is done much like a magazine or book, where a higher number such as 
Volume 2 represents a more recent release.



Public-Domain Programs

A public-domain program is a program that belongs to the public.    When a program is 
designated as Public-Domain, no individual or company can claim ownership of the program.    
As such, using a public-domain program costs you nothing, and is freely distributable.

see also Freeware
see also Shareware



Shareware Programs

A Shareware program is a program that is owned and Copyrighted by an author, but which you 
have been granted free limited rights to use.    A Shareware program is just like every other 
program that you can find in a retail store, except that you are allowed to try a Shareware 
program before you decide whether you want to buy it.    In this respect, Shareware is a very 
advanced marketing method.

Your free limited rights to use the program are determined by each Shareware programs author, 
and you must read the authors documentation to determine what rights you have been granted.    
Many times, you will be granted a free period of evaluation time, such as 30 days, to determine 
whether you like the program.    If you decide to use the program beyond this evaluation time, 
you must send the author the requested payment (usually far less that retail programs of the same
quality) in order to purchase the software.

see also What Is Shareware?
see also Public-Domain
see also Freeware



System Files

A system file is a special file which is recognized and used by Windows to perform certain 
functions.    Examples of system files are:

Windows Screen Savers (.SCR).
Truetype Fonts (.TTF)



Interface, documentation, and compilation are Copyright © 1995, Limelight Publishing, LLC.    
All Rights Reserved.    All Limelight Products are trademarks or registered trademarks of 
Limelight Publishing, LLC.    Other brand and product names are trademarks or registered 
trademarks of their respective holders.

The software described in this document is furnished under the provisions of a license 
agreement.

The Shareware and Freeware programs contained on this product are owned and Copyrighted by
their respective authors.    Public Domain programs are the property of the public.

Super Show & Go™ is a trademark of LaserSoft, Inc.
CD Navigator™ is a trademark of LaserSoft, Inc.
MS-DOS® is a registered trademark of Microsoft Corporation.
Microsoft® Windows™ is a registered trademark of Microsoft Corporation.

Information in this document is subject to change without notice and does not represent a 
commitment on the part of Limelight Publishing, LLC.    No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, for any 
purpose, without the express written permission of Limelight Publishing, LLC.



Hot IBM Games!
Check out the LaserSoft companion CD's for all of the hottest IBM games!

Doom Companion Edition:
* Maps of every level,
* Game recordings,
* Level editors,
* Hints and cheat codes,
* Sound editors,
* Plus TONS more!

Demon Gate

* The ultimate Doom challenge!
* The ultimate Doom challenge!
* Six hundred and sixty-six totally new levels!

Magic & Mayhem for Heretic:

* One THOUSAND and SIX HUNDRED new levels for Heretic!
* New music,
* New sound effects,
* New wall textures,
* And all new levels.

Rise of the Triad Deluxe Edition:

* The orginal shareware version plus 6 all new levels from Apogee,
* Modem support,
* Configurable violence levels (none to EXCESSIVE!),

Dimensions for Descent:

* Seventy-five all new, fully 3D levels!
* Each level the creation of a Descent enthusiast.




